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Introduction
Communicate: In Print 2 is a Desk Top Publishing program for making printed 
worksheets and books. It has the benefi t that it can easily support writing with pictures 
or symbols as an aid to literacy. It is provided with the Widgit Symbol set, that has some 
11,000 line drawings to support literacy in both color and black & white. There are also 
over 1500 colored graphics and photographs. These colored pictures can be used on 
their own or put together to build scenes to illustrate writing. You can also use your own 
images in the program.

The Widgit Symbol set has been developed in consultation with many language 
specialists and has an underpinning structure to aid communication. The basic principles 
of using symbols are described at http://www.widgit.com/symbols/.

This tutorial booklet provides an introduction to the program. If you  follow this booklet 
through, you will create an 8 page book that uses all of the key features of the program. 
We urge you to work through this, it will not take long, and will give you a good grasp 
of the program to get you started.

There is also an extensive electronic reference manual, which is searchable. Click on Help, 
on the menu, to access this. 

For a full reference manual for Communicate: In Print 2 see the Start> Programs menu 
when you have installed the software. The most up to date version of the Reference 
Manual can also be accessed on-line at http://www.widgit.com/help/inprint

A PDF copy of the documentation is also provided on the CD if you wish to have a 
printed reference manual.

The Widgit web site will also have a large number of example fi les and practical tips on 
using Communicate: In Print 2 in English.
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Introduction to Communicate: In Print 2

A tutorial to show you the key features of the program.

1. Starting to write

Open the program
This is the main creative writing screen. This shows the main toolbars. It is possible to 
have a range of simpler toolbars. If someone has previously changed the setting you can 
fi nd how to change it back in Section 12.

•

This shows the main toolbars and on the right there is the Edit Panel for formatting 
your writing. The four writing buttons on the left show the different kinds of writing 
frame that you can make. You can write in a frame that freely expands as you write, or 
in a frame of fi xed size where the contents will be automatically adjusted to fi t in the 
frame. These frames can be for plain text or for symbol supported text. The buttons 
shown below allow you to choose the type of writing frame you want.

Free Symbol frame for writing freely in symbol supported text.

Fixed Symbol frame has a fi xed size so that the contents are automatically 
sized if necessary to fi t into the space.

Free text frame that will expand as you write to fi t the contents.

Fixed Text frame where the text is sized to fi t.
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1a. Writing with symbols

Click on the Free Symbol writing button.

Drag a box for writing on the page as shown opposite.
Into this box type A book about In Print.
Notice that the symbol appears when you enter the space following 
each word.
As you fi nish each word look at the symbol choices box on the right, at the 
bottom of the Edit Panel. It shows all the graphic options for that word. 
Change the displayed graphic by clicking in an alternative.

You may want to ‘turn off’ the symbol attached to a word.
Click in the Hide Symbol button in the Symbol Choices viewer.

1b. Using colored or monochrome symbols

Click on the icon that informs you that you are using the colored images.

You will see that the symbols change to black and white and that the icon 
changes to indicate this.

Highlight just the words “in print”. Now switch between color and 
monochrome. You will see that only the highlighted sections change. This 
enables you to have documents with mixed black and white and colored 
symbols.

Type the word “happy” making sure that you are showing colored symbols. 
This brings up a face which has the default skin tone. Click on the skin tone 
icon repeatedly to see the fi ve different skin tones.
To change the skin tone for just one symbol make sure it is highlighted 
before clicking the skin tone button.

1c. Writing in a Fixed Text Frame

Click on the Fixed Text button.

Drag a new frame. This will add a Fixed text frame to your document with 
a border ready to type in.
Into this frame type Getting started with pictures symbols and words.

•

•
•

•

•
•

•

•

•

•

•

•

•

•
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Right Click in the frame and you will see blue drag points appear.•

Use the left mouse button to move the frame or to drag these points to re-
size the frame.
Adjust the sizes and then move the two writing frames so that the layout is 
similar to the illustration below.
Right Click again in the frame to change the frame back into Create 
mode.
You can use the buttons in the panel on the right (the Edit Panel) to 
adjust the positioning and appearance of text and graphics.

1d. Adding a picture

Click on the Graphics button
This will change the panel on the right to 
show the Graphics Panel.

The default area for the graphics source will be a folder called Widgit 
Pictures. This has several folders of colored graphics. Choose the folder 
called General. Click on the picture of a book and then click back in the 
center of your page.
Re-size the picture to make the page look similar to the screenshot below.

•

•

•

•

•

•

•
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2. Speech bubbles

Turn to the next page by clicking on the Next Page button in the bottom
navigation toolbar.
If there isn’t a page already there one will be created.

You can choose to see the document as single pages or as a double page
spread.
The buttons for choosing between these two displays are:

  and

Set the display to single page. If the button is set to a double page, change 
by clicking on it. It should change to a single page icon. 

Add two graphics to the page from the animals folder: the camel and the 
frog. The folder icon will take you back to the Widgit Pictures folder.

Click on the Speech Bubble button:

This will show the Speech Bubble panel. Below each style of bubble there 
are four points, these represent the direction of the mouthpiece from the 
bubble.

Click on the point you want under your chosen bubble style and then drag 
a frame on your document as below.

You can type straight into the speech bubble. To display the editing panel 
again, click on the Create icon (top, left).

To change the writing from text only into symbol writing use the 
F10 key or click on the text or graphic button in the Edit Panel 
before you start to type.

•

•

•

•

•

•

•

•

•

•
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You can change the direction of the mouthpiece at anytime.

Click in the bubble you want to change and then click on the Speech Bubble button 
again. This time choose from the four points at the bottom of the panel. Clicking in 
these will change the orientation of the bubble.

Use the Expand button to make the text (and symbols) as large as possible 
in the frame.

•

•
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3. Photographs and other pictures

Create a new page (number 3) using the right arrow button in the page toolbar.

On this page add a large Fixed Symbol frame to fi t the top half of the page.

3a. Setting the frame appearance

Click in this frame and then click on the Frames and Pictures menu and 
then select Appearance…

•

Change the appearance as shown above, and then click OK.

3b. Adding a photograph to fi ll a frame

Click on the Graphics button in the left toolbar:

Choose the Photos folder in the main Widgit Pictures.
Click on the squirrel photograph and then click in the frame. 
The picture will automatically fi ll the frame.

•

•

•
•
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3c. Adding photos to words instead of symbols

Click on the Free Symbol writing button,and drag a box underneath the photo.

Type into this There are squirrels and rabbits in the forest. This will be 
automatically symbolized. It would be nice however to use real photographs for 
‘squirrels’ and ‘rabbits’.
Click on the Graphics button again, and then click fi rst on the squirrel picture, and 
then on the word squirrel. The symbol will be replaced by the photo.
Repeat this for the rabbit.
Click on the Graphics button again to remove the Graphic panel.
If you click back in the word squirrel you will see that this has been added to the 
symbol choices box.

•

•

•

•
•
•

The choices available when you type are set by a ‘Wordlist’ It is possible to add this 
graphic to your wordlist so that it can be used in other documents. This is done from 
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the Wordlists menu, via Save wordlist changes. Please don’t save this example, 
however, in case somebody else wants to follow this tutorial. For further information 
on wordlists look in the electronic Reference Manual. Click on Help on the Menu Bar to 
obtain this manual. 

If you are not sure what a picture represents in the graphic viewer you can right click on 
the thumbnail in the Graphics Panel to see the fi lename and also to hear the name of 
the fi le.

3d. Changing the size of thumbnails

The default view of the Graphics browser shows three thumbnails on each line. You can 
change this to show larger images from Thumbnails, under the View menu. This will 
display one, two or three columns of images. The program automatically stores the last 
used setting. 

3e. Using your own pictures

When you open the Graphics panel the default area it opens at is Widgit Pictures. 
However, you can navigate to anywhere on your computer or 
network to fi nd your own pictures.

Use the little down arrow beside the current folder name to see 
the folder paths, or click on the folder icon with the up arrow to 
move up a level:

You can easily return to the main Widgit Pictures by clicking on 
that button at the bottom of the Graphics panel.

You can also designate two alternative areas that can be easily 
reached by clicking on the Pictures A or Pictures B button.

By default Pictures A is linked to your My Pictures folder in My Documents. 
Pictures B is linked to a folder called Shared Images that has been created for you 
to store your own pictures in. The links to these areas are set up from the Start-up 
Preferences. Go to the Options menu, Start-up preferences and then choose the Graphic 
Locations tab. There is more information on the Start-up preferences in section 11.

NOTE:
When you save a document, copies of any graphics that are not in a Widgit area are 
saved with the document so that you can take that fi le to another machine with 
Communicate: In Print installed, and you will not lose the pictures. There is more 
information on graphics and saving fi les in the Electronic Manual, which can be found in 
the Help menu.
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4. Building a scene

Create a new page (page 4).
Open the Graphics panel and then open the Animals folder.
Put two green dinosaurs on the page and make them large.
Hold down Shift when you re-size to keep the aspect ratio (ratio of height to width).
If you have distorted the picture you can always double click on a graphic to restore
the aspect ratio.
You can fl ip a graphic by dragging the right or left blue drag points right through to
the opposite side. Flip one of the dinosaurs now, as shown below.

•
•
•
•

•

4a. Changing to Adjust mode

Up to now you have worked entirely in Create mode. To make adjustments to the 
layout of the images you will need to change to Adjust mode. On the left toolbar there 
is a button for each of these two modes.

Click on the adjust mode button:

The left toolbar changes to show you the Group and Arrange buttons, and the top 
toolbar changes to show the rotate icon instead of speech and spelling. These are all 
explained below. Another visual indication of the mode is the background color. Create 
mode is blue and Adjust mode is green.

4b. Editing the  colors of Widgit Pictures and Symbols

Select one of the dinosaurs and click on the Palette button.
This will open the palette for this picture.

Click on any of the colored parts of the dinosaur and you will see the matching color 
square highlighted.

•

•

•
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Click on that color square to get the color dialog box. You can now choose a different 
color. Click OK on the color palette. Do this for all of the colors until you have a blue 
dinosaur. Then click OK on the panel. If you click Cancel at this point the graphic will 
return to its previous color palette.

•

You can also change the colors within a colored symbol. Simply click in the word 
attached to it and then on the palette icon exactly as above.

4c. Arranging and Grouping

Create a small group of dinosaurs as a start to making a dinosaur scene. You can stay 
in Adjust mode while you do this.

Use the Arrange buttons in the toolbar to change the front-to-back order of the 
graphics.

Move to the front.

Move forward one place.

Move backwards one place.

Move to the back.

•

•

•
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If you fi nd that you cannot highlight a graphic because it is at the back and underneath 
others, then hold down the control button and at the same time press the left 
mouse button. Each time you press the mouse button a different item in the ‘stack’ is 
highlighted.

Grouping images

You may want to move or re-size the group of items that you have put together.

Click on the group button. This will now start to fl ash.

Click on all of the items you want to group, and then click on the group button 
again. The individual frames with blue drag points will be replaced by a single group 
frame with yellow drag points.

Alternatively, you can drag over the set of images you want to group and then 
click on the group button, or you can hold down CTRL + Shift and click in turn on 
the images that you want to group. Click on the group button when they are all 
highlighted.

Use one of these yellow drag points to re-size the group or move it as a whole.

You can ungroup a set of items with the ungroup button:

To complete the scene, fi nd a suitable background from the Environment folder.

Size this to cover the whole group of dinosaurs.

Then, click on the button to send it to the back:

•

•

•

•
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You may want to adjust the position of individual items in the group to fi t with the 
background, without ungrouping the whole picture.

Right click on the item you want to move. This will highlight an individual item. You 
can then adjust its size or position with the right mouse button. It is still part of the 
group and can still be moved as a whole.

•

4d. Rotate 

This feature is only available in Windows 2000, XP and above.

You can rotate individual graphic or text frames, but not groups.

Ungroup the dinosaurs using the ungroup button.

Select your item and then click on the rotate button. 
The corner drag points change from square to round. 
Drag one of these points to the desired position and release.

You can also rotate by setting the rotation angle from the Frames and Pictures menu.

You cannot color a rotated graphic, or edit the text in a rotated frame so it is best to 
make all the changes you want before you rotate it. If you want to edit a rotated frame 
double click on it and it will return to normal. Make any changes and then re-rotate it.

Bitmap type fi les (such as photographs) can only be rotated at their original aspect ratio. 
If you rotate a stretched bitmap graphic it will automatically be adjusted to its original 
aspect fi rst.

•

•
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4e. Adding labels 

A label can be made with a Fixed writing frame with the border set to be 
transparent.

Return to Create mode:

Create a small Fixed Text writing frame and type in some text for the label.

From the Frames and Pictures menu, go to set the Frame Appearance, click on 
the button to make the border color transparent, then set the line color to black.

You could position the labels on the picture, or you could leave them at the 
bottom of the page as an activity for a student to complete.

•

•

•

•

•

To make this into an activity for a student, you may like to hide the panel on the right.

Click on the Hide panel button on the top toolbar:

You may also want the program to offer a simpler toolbar menu to students. These can 
be found under the View menu. (See section 12) 

For further examples see the examples folder - Activities to do on screen - Color book 2.

•
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This screen will show three rows of graphics each having an ‘odd-one-out’.

5a. Guides 

First add three horizontal guides so that you can line the pictures up. A guide 
is picked up from the black lines at the top and left edges of the background. 
As you move your mouse over the line the cursor changes.
Drag the guide into place.
Place the guides roughly in place to allow for three rows of pictures.
You can hide and show your guides from the view menu.

5b. Rulers 

If you want to arrange these guides accurately you can use the rulers to measure the 
gaps and position the guides accurately.
If you cannot see the rulers on the page, go to the View menu and click on Show 
Rulers.
You can double click on a ruler to make it free fl oating. You can then drag the blue 
bar at the top to position it where you want to measure.
Double click again to return the ruler to its usual position.

•

•
•
•

•

•

•

•

5. More on layout and alignment

Create a new page (Page 5).
Create a Free Symbol writing frame and type in the following heading: Which
pictures are different. Even though this is a Free Symbol writing frame, you can still
add a border. Use the Frame Appearance to put a border around the heading.
The symbol for Pictures may show the plural qualifi ers. You can show or hide the
qualifi ers via the View menu.

•
•

•
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5c. Locked Guides and Book Guides

You can LOCK the guides so that you don’t accidentally move them:

Right click on the guide to see the guide menu.
Click on LOCK this guide in place.

If you want to put a particular guide on every page – for example for a margin or to 
line up a heading, then you can make any guide into a BOOK guide. Choose this from 
the guide menu shown above. This will copy the guide to every page in the book. If 
the guide is already locked then the Book guide will also be locked. If not, then when 
you move the book guide on one page it will be moved on all pages.

You can tell the status of a guide from its color. Ordinary page guides are Green, book 
guides are Red and locked guides are Grey.

5d. Duplicate 

Add the images for the odd-one-out activity as described below:

Line 1: Refl ection - This will have one item fl ipped horizontally.

Put a graphic on the fi rst line.
Click on the Duplicate button to make three copies of the same frame.
Click on one of these and drag it through itself to fl ip it.
Arrange these evenly along the line.

•
•

•

•
•
•
•
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Line 2: Color – this will have one item colored differently.

1. Put four copies of an item on the next line as you did before.
2. Go to Adjust mode and select one item to color.
3. Click on the palette button and change the colors as you did previously.

Line 3: Rotate – one item will be at a different angle to the others.

Put your four graphics on the line.
Click on one of the graphics and then on the rotate button.
Use one of the corner drag points to rotate the picture so that it looks different from 
the others.

•
•
•
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6. Tables

6.1 Creating a table

You can create tables from a text or symbol frame.
Create a new page (Page 6).
Create a graphic frame using the Fixed Symbol writing button,
and set the appearance as shown below:

•
•
•

The border is set to be transparent but with a width of 8. This will set up a transparent 
gap between the frames in the table.

Set the other properties of this frame, such as center justify.
Click in this frame and then go to the Frames and Pictures menu and click on Make 
a Table. This will give you a dialog box to enter the number of frames you want in 
the table and give you options to size the grid.

•
•

Fixed table size: This will be the size when printed. It will warn you if the size set is 
larger than the paper. 
Fixed cell size: This sets the width and height of each cell in the grid. It will warn 
you if the size set is larger than the paper. 
Use current size: This will make the table using the size of the cell created on 
screen. 

•

•

•
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When you click OK it will create the table. The frames will be grouped and so the frame 
will have yellow drag handles. You can move and re-size the table as a whole by moving 
the yellow drag points. 

You will need to click away from the table then click back inside a cell.•

You can now fi ll in the contents of the table as you wish.•

6.2 Editing a table

Re-size the table to a specifi c size by selecting Edit table size, from the Frames and 
Pictures menu. 

To merge cells select the cells you want to merge by clicking on them whilst holding 
down Shift+Ctrl. Then select Merge cells from the Frames and Pictures menu.  
Similarly you can Unmerge cells from the menu. 

Insert rows or columns by selecting a cell and then choosing the option you want 
from the Rows or Columns menus under the Frames and Pictures menu.

•

•

•
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Altering column widths and row heights. Go to adjust mode (second button 
on the left hand toolbar) and right button click a cell in the row or column you 
want to change.

•

Drag the right hand 
blue drag point. 
The cells in the 
column are then 
all automatically 
highlighted and the 
column width can be 
changed.

Click away when you have adjusted the column. You can similarly adjust the row 
height similarly.

To merge cells. In adjust mode, select the cells you want to merge by left clicking 
on them whilst holding down Shift+Ctrl. Then select Merge cells from the Frames 
and Pictures menu.

Combining changing row heights/column widths with merging. You can 
change the row height even if the row intersects a merged cell. Similarly with 
column widths. The pictures below show how you can still change the width of the 
middle column.

To unmerge a cell.  Again in adjust mode right click in the cell. Then select 
Unmerge cells from the Frames and Pictures menu.  The cell will unmerge and 
each cell takes it width and height from the relevant row or column.

•

•

•
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Change the appearance of one or more highlighted cells and going to Appearance 
under the Frames and Pictures menu.

•

Note: The heading on this page was added separately.

Key Points to Remember.
(a) Go to adjust mode (second icon on the left) to make these types of changes
(b) Use a right button click to select a single cell in the table.
(c) Hold down Ctrl+Shift and left button click in those cells you wish to highlight

together.

6.3 Printing large grids and overlays

The screen will normally indicate the printing limit of the currently installed printer. This 
is the red dotted line near the edge of the paper. You will notice that as you move items 
over this line they are clipped (and no longer show) to give a tidy edge to the page and 
indicate what you will see when you print the page.

Some printers will actually print within some of that dotted area. So if you need a grid 
very near the edge of the paper you may want to override the page clipping to get the 
absolute maximum printing area. This can be done from the Options menu. 
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7. Lines, arrows and an alternative way to add pictures

Create a new page (page 7).
Put a heading Which words begin with b or d?

7a. Getting pictures from a list

It is easy to fi nd the colored pictures from the Widgit Pictures folder by navigating to the 
relevant topic folder. It is also easy to fi nd the symbol line drawings by typing words into 
a Fixed Symbol writing frame. However there may be times when you want to fi nd 
pictures directly from a word, but not show the word in the document.

 Open the graphic panel, and click on the third tab on the top labelled Use List.

You can choose whether you want to use the symbol list (from the current wordlist) 
or picture list (the colored pictures from the Widgit Pictures).

Type the word to identify the picture you want and click Find.

You will see all the pictures available for that word in that wordlist.
Click on the one you want and then click in the document to place it there.

•
•

•

•

•

•
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7b. Lines and Arrows

To add lines to your page, click on the Lines tab in the Graphics panel

Choose whether you want single lines: 
 

or multiple connected lines:
 

The buttons are yellow when they are active, otherwise they have grey backgrounds.

If you want horizontal or vertical lines then also choose the right-angle 
line button:

 
Choose the arrow style (with or without head), the line thickness and fi nally 
the line style.
Click where you want to start the line. Do not hold the mouse button down. As 
you move the mouse pointer you will see an indicator for the line.
Click again to fi nish positioning the line.
To stop drawing lines you can:

Double click
Click on the blue/green background
Click again on the line button.

•

•

•

•

•
•
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8. Building a document

You have now covered most of the main concepts of the program.
This section gives some additional help with building documents and introduces some 
additional writing support facilities. 

In this section you are going to create a page like the one shown below.

Create another page (page 8).
Across the top type a title in text only.
Drag the mouse over this to highlight it.
Click on the Text larger button in the text editing panel until it is size 48:
Click on the Bold and Shadow buttons to change the style:

    and    

Open the graphics panel and click on the Lines tab.
Add a horizontal line under the title and then a vertical line in the center to make 
two columns. You can edit a line by Right clicking on it to show the blue drag points 
and then move it or change its appearance.

•
•
•
•
•

•
•
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Use the different types of frames to create the example above with symbols, text and 
pictures as shown, with the text size 20 and symbol size 16.

8a. Changing the words linked to a picture

When you write the caption ‘Squirrel found eating a toffee’ you will fi nd that there is no 
symbol for’ toffee’. The most suitable symbol is ‘candy’.

Type the phrase with the word sweet, to get the symbol you want. Then click in the 
word ‘candy.’

Click on the Change Text button to remove the text.

Type in the new word ‘toffee’. Press the right arrow key on the keyboard.
It is possible to save this change to your wordlist from the wordlist menu. There is 
more on wordlists in the manual.

8b. Zoom

When you are placing a lot of content on a page it may be easier to zoom in on 
the page.

You can zoom out or return to Fit to Window using the other buttons.

8c. Speech

You can listen to the text in a frame using the Speak button.
Click in the fi rst word in the top left symbol writing frame.

Click the speak button to hear the fi rst sentence.
Click it again to hear the next sentence. 
This way you can click through a frame listening to each sentence in turn.

Click on the repeat Speech button to hear a sentence again:

The speech in Communicate: In Print 2 is not intended for use as a talking book, but 
only as a support for writing. Sometimes it is useful to have audio feedback to help the 
construction of sentences as well as identifying spelling mistakes.

The program can work with SAPI4 or SAPI5 voices. If you choose SAPI4 from the Speech 
menu SAPI4 or SAPI5 then a combo box appears from which you can select the voice you 
require.

•

•

•

•
•

•
•

•



30

If you choose SAPI5 then this combo box disappears and the program will use the 
default SAPI5 voice on your machine.

The default machine SAPI5 voice can be changed from the Windows Control Panel 
selecting the Speech button.

8d. Bullets and Indents

Add a new Free Text frame underneath the “squirrel…toffee” frame, with a text size 
of 18, then write in the text below.

•

Add bullets with this button on the text panel:
 

Indent or cancel indent with these buttons:       and  

8e. Spell Checker 

There is a pictorial Spell checker to help.

Turn on the Spell checking features:
From the Text menu tick the Mark spelling mistakes option.

•

•

•
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Into a Fixed symbol frame type the words shown above, including the mis-
spellings.
Click in a text or symbol frame and then on the spell checking button on 
the top toolbar. This will open the Spell checker panel.

•

•

The spell checker shows the suggestions together with an illustration whenever possible. 
In the example above there are both the symbols for squirrel and also the photograph 
from page 3.

Click on one of the words in the list, and then Try the new word.
You will see the word added to the document.
Click on Hear the sentence. This may help in choosing the correct word.
If, having seen and heard the word in context, you are not happy with your choice, 
you can click on Back to original word to try a different alternative.

For some phonetic mis-spellings you may fi nd that spell checkers do not suggest 
alternatives. Communicate: In Print offers the facility for adding these. From the Text 
menu select New Suggestions. In the top box enter the mis-spelling. In the lower box 
enter all of the correct word suggestions relevant to that mis-spelling. Separate different 
entries with a comma. Then click the bottom button to add this to the speller.

Finish the document to match the picture.

•

•
•
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9. Page numbers and Master items

Lets fi nish this introduction with a few little extras:

9a. Page Numbers

On Page 2 make a small fi xed text box in the bottom center.
Into this type a ‘Not sign’  [This is obtained with shift on the key to the left of number 
1].
As soon as you have typed the ‘Not sign’ the text box will show the number of the 
current page.

You may want this page to be page 1 and not page 2. You can start page numbering at 
any page you want.

To change the start page for page numbers go to the Edit menu. 
Select Start Page numbers at…

•
•

•

•

Enter 2 in the box. You will see that the page number on page 2 changes to be 1.

You will now want to put a page number on all the pages from page 3 onwards. Click on 
the Frames and Pictures menu, and then on Copy frame to pages.

•

You can enter in specifi c pages, or you can type 3- to imply from 3 to the end.
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Choose the option to put this item on all pages, and Start from page 1

Click the next page button:

Display the booklet in 2 page format:

•

•

•

9b. Master items

Go to the fi rst page using this button:

In the bottom left corner place a small text writing frame and type your name 
in it.
From the Frames and Pictures menu click on Master items and then choose Make 
master item.

•

•

•

The following dialog box will open:
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You will see the master item is shown on both of these pages. Because it is a master 
item, if you make a change to it on page 2 – for example by moving it, or changing the 
frame properties, then it will replicate that change on all pages. You can recognise a 
Master item because it has Red drag points.

Put this master item in the bottom right corner of the page.•
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10. Printing

Communicate: In Print lets you print your work in a variety of ways
From the File menu, select Print to open the Print dialog:•

You can choose to print as a book ready to fold in half or as single sheets.

10a. Printing as a book

Printing as a book produces a printout ready to fold into a booklet, with two document 
pages per side. It will scale the pages down, so that two pages will fi t to one side of 
paper. The software calculates which pages to put together so that it all fi ts together in 
the right order when it is printed.

10b. Printing as sheets

If you choose to print as sheets, the software will scale the pages to fi t the paper size. 
Set as single sided and each page will be full size on a separate sheet. Set as double 
sided and it will print odd numbered pages and then ask you to turn the stack to print 
the even numbered pages on the back.
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10c. Single sided and double sided

If you choose double sided, it will print all of the ‘top’ sides and then ask you to turn the 
stack of paper over ready to print on the other side. You will need to do a test run to 
determine two aspects of printing the second side. First you need to test to check which 
way round you need to put the paper for the second side. Each printer type may be 
different and there will also be a difference if you are printing landscape or portrait.

You will also need to test in which order the pages are printed on the second side. You 
may need to change the setting of the button Print second side in reverse.

Each type of printer may be different and you will need to test and note these details for 
each printer that you use. It might be a good idea to put a sticker on the printer saying 
what to do. (Section 19 has a guide to printing to help you fi nd out which settings are 
right for your printer.)

10d. Paper size  

In Print will scale your document to fi t the paper size selected in the Print set-up. If you 
have selected Letter sized paper and choose Print as a book, then the resulting book 
will be small, half of letter size. If you made your document portrait then the book will 
be ready to fold to the left. If you have a screen document which is landscape then the 
book will print so that the fold is at the top.

If you have chosen legal paper, then the documetn will be scaled to fi t centrally on this 
sized paper. 

If you have larger paper than letter, then the pages will automatically be scaled to fi t the 
selected paper size, either as a book to fold, or as single full sized sheets.

Once you have completed the booklet in this tutorial try printing as both a book and as 
sheets.
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11. Saving your preferred settings

You can confi gure most of the program settings so that the software opens with your 
normal preferences. These are saved in the Start-up Preferences under the Options 
menu.

There are eight tabs in the Preferences Dialog box:

Frame Appearance
Sets the default appearance of frames.

Wordlists
Sets the main wordlist and a subsidiary wordlist if you want one.

Speech and Spelling
Sets the Speech voice, automatic speech options and whether spelling errors are 
shown by default.

Text  Graphics
Sets the default font, font size and color for text and graphic writing, and the 
graphic size for these modes plus the default size of graphics added to the page from 
the graphics viewer.

Graphic Locations
Sets the path to the Widgit Pictures folder and to two other graphic locations of your 
own choice. These can then be easily found by clicking on the Pictures A or Pictures B 
buttons at the bottom of the graphic viewer.

Buttons and View
This sets the default Buttons on load, whether the view is single or double page view 
and some of the other view settings. You can also set whether you see Rulers and 
Print area (the dotted red line around the printable area of the page).

System and Printing
You can set the system to auto-restore in case of problems. Under this tab you can set 
the frequency with which the program updates the ‘Auto-restore’ with the current 
state of your document.

The print defaults sets the default printing as Book to fold, or as sheets, and whether 
the printed pages are to be single or double sided. Remember if you don’t have a 
double-sided printer you can still select double sided printing. You will be instructed 
when to turn the pages over and re-place them in the printer tray. (Duplex printers 
can print both sides in one go.)

Color Settings
This tab enables you to set whether the program starts with color or black and white 
symbols. It also allows you to set the default skin tone.

You can over-ride these settings at any time while you are working, but these 
settings will be restored when you next launch the program. There is more 
information on these in the Reference Manual.
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12. Toolbars

The toolbar buttons illustrated throughout this introduction are for the main toolbars 
with the full set of buttons available. Also the detail of the buttons changes with 
the screen resolution of your computer. The icons shown here are for a resolution of 
higher than 1024x768, however other resolutions use different buttons to give you a 
maximum work area on the screen.

There are some simpler button sets designed for students.
The toolbar buttons can be changed from the View menu.

The options are:

Advanced

This has the full set of buttons available.

Intermediate

Buttons for a few of the more complex actions are removed, such as insert and delete 
pages, bullet points, the text to graphics button and expand the contents of fi xed 
frame. Also instead of the four ‘front to back’ buttons there are just two – move 
forward and move backward.

Basic

This allows creating and writing in Fixed and Free frames, adding graphics, but not 
speech bubbles. It also has the ‘Turn page’ button but not the ones to go directly to 
the front or back of a book.

Easiest

This is intended for students who are using ready made templates or on-screen 
activities. You can write and add graphics and frames but cannot change to adjust 
mode.
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New document

Open fi le

Save

Print

Cut

Copy

Paste

Duplicate frame and contents

 Undo

 Redo

13. Index of Toolbar Buttons

The toolbars change automatically as you change mode or function.

13a. Mode toolbar

There are two modes, changed with the Mode toolbar:

Create Mode

Adjust Mode

13b. The Main toolbar
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Hide panels

Display panels

Edit the palette of a metafi le graphic

Indicates and changes the display between colored  and 
monochrome.

Cycles through the fi ve possible skin tones.

In Create mode the main toolbar also has these buttons:

Speak current sentence - at point of cursor

Repeat the last speech

Check spelling

Change the text associated with a word (you can also do this with F11)

In adjust mode the main toolbar also has this button:

Rotate frame

13c. The Page toolbar (independent of mode)

 Go to fi rst page

 Go to previous page

 Go to next page. This will also create a new page if there isn’t one
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Go to end of document

Single page view. ( This toggles with double page view)

Double page view (except for page 1, which is always shown as a single 
page)

Zoom in

Fit in window

Zoom out

Insert page(s)

Delete page(s)

13d. The Create toolbar

Start to write in Symbol mode in a free sized frame
Click on this and then drag a box of the width you want

Start to write in a fi xed symbol frame
Click on this and then drag the box to the size you want

Start to write in a free text frame
Click on this and then drag a box of the width you want

Start to write in a fi xed text frame, or create an empty frame
for a graphic. Click on this then drag the box to the size you want

Insert a speech bubble

Expand the contents of a frame to be as large as possible

Open the Graphics viewer
Click on this again to close it
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Symbol writing mode. Toggles with Text writing mode (Also change this 
with F10)

Text writing mode. Toggles with symbol writing mode (Also change this 
with F10)

Remember the current text and graphic settings for the currently selected 
frame type. Only during current writing session. (Use the Options menu 
for permanent settings.)

Insert bullets
Click again to remove bullets

Indent (top button)
or undo indent (lower button)

13e. The Edit panel

Graphic alternatives display. Click on the 
graphic in this window to change the one in the 
document. Alternatively click in the word and 
then press F9 to cycle through the choices

Font

Text or Symbol mode

Set local style

Paragraph alignment 
left, center and right

Font styles, Bold, 
Underline, Italic and 

Shadow

Bullets and Indents

Graphic size, Graphic 
larger or smaller, 

Graphic color

Vertical alignment 
in fi xed frames top, 
center and bottom

Hide symbol attached 
to word
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13f. The Adjust toolbar

Group objects. Click on this and then on each item you want to group, or 
drag over the items with the mouse to group and then click on this to group 
them.

Ungroup

Move to the front

Move forward one place

Move backwards one place

Move to the back

13g. The Lines panel

Single line

Multiple lines connected 
together

Force lines to be horizontal or 
vertical. Use this with single or 
multi-lines

Line color
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14. Keyboard Shortcuts

Below is a list of the most common shortcut keys. The full list is given in the Reference 
Manual.

Ctrl  +  A Select all (in the current writing frame)
Ctrl  +  C Copy the highlighted item(s)
Ctrl  +  X Cut the highlighted item(s)
Ctrl  +  V Paste the copied or cut item(s)

Ctrl  +  Z Undo last action
Ctrl  +  Y Re-do

Ctrl  +  G Group selected items
Ctrl  +  F Ungroup selected items

Ctrl  +  Q Send selected item to the back
Ctrl  +  W Send selected item backwards
Ctrl  +  E Send selected item forwards
Ctrl  +  R Send selected item to the front

Ctrl  +  B Make highlighted text Bold
Ctrl  +  I Make highlighted text Italic
Ctrl  +  U Make highlighted text Underline
Ctrl  +  H Make highlighted text Shadow

F9  Cycle through the symbol choices for a word

F10 Toggle between text writing and symbol writing modes

F11 Remove the text linked to a word ready to add alternative text

Ctrl  + Shift + Left Click      Multiple selection of items on the page

Ctrl + Alt + C         Copy selected frame to the Windows clipboard
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15. Graphics included with the program

There are two main sets of graphics included with Communicate: In Print 2 - the Widgit 
symbols and Widgit Pictures.

15a. Widgit Symbols

This is a set of some 11000+ line drawings to support literacy in both monochrome and 
colored formats. More information is available at www.widgit.com/symbols 

The easiest way to access symbols in the program is through a wordlist. The main 
wordlist is Widgit (with a version number following). eg. Widgit_US 09.cwl.

An alternative list is Widgit_US all 09.cwl. This also includes all of the graphics from 
Widgit Pictures that represent single words. This may be useful in instances, such as 
communication books, where you want the color picture with the word rather than the 
line drawing.

15b. Widgit Pictures

There are approximately 1500 colored pictures also included with the program. These 
are normally used direct from the graphics folders (see below) but those pictures that 
represent single words can also be accessed through a wordlist. This may be useful in 
instances, such as communication books, where you want the picture with the word 
rather than the line drawing. There is more information on the wordlists in section 16.

The colored graphics are organised into topic folders. Most are clear from the folder 
titles. The following notes may help you:

Environment: This has a set of basic backgrounds at the top level, and there are 
folders for items that might be used to add to these to make scenes.

Books: These are the graphics specifi cally made for some of the example books.

Coloring in: A small number of pictures are provided in pale colors or shades of grey 
which can be used for coloring using the palette editor.

Patterns: This contains several folders:
Borders  borders and page dividers
Colors  a small number of items in a range of standard basic colors for 

color work
Numbers  numbers in dice layout
Shapes  Some basic geometric shapes as fi lled color ready to color using 

the palette editor and the same shapes in outline
Money  images of UK coins and Australian money.

•

•

•

•
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People 1 has a range of people and characters to illustrate creative writing.

People 2 has a number of basic people in different colors and also a sub folder called 
Body Parts, which has the bodies and heads separated so that different combinations 
can be made.

Photos has a variety of photographic images organised roughly into topic folders.

Scenes has a number of compilations of graphics to give ready made scenes.

•

•

•

•
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16. Wordlists
 

16a. Wordlists with the program

Communicate: In Print 2 comes with the Widgit symbol set and the colored Widgit 
Pictures. The wordlists are the mechanism by which you select which symbols you use in 
symbol writing mode.

A wordlist is a fi le that links the word and graphic. If you type ‘cat’ into the computer in 
symbol mode, then the computer looks up the word ‘cat’ in the wordlist and so fi nds out 
what graphic to produce. You can have different wordlists linked to different pictures. 
For example there are wordlists for the Widgit symbols and for the identifi able objects 
in the Widgit Picture set. The image produced when you type a word depends on which 
wordlist the program has in memory.

The wordlists included with the program are:

Widgit_US XX.cwl  eg Widgit 08-11.cwl  where XX is the version number. This is the 
complete Widgit symbol collection available at that date.

Widgit Pictures.cwl This is a wordlist for all of the main objects in the Widgit Pictures 
folder.

Widgit_US all XX.cwl  has all of the pictures and symbols available.

New symbols are available by downloading symbol updates from www.widgit.com/
symbolupdates Each new symbol update is accompanied by a new set of wordlists. You 
will need to replace your current wordlist with the new one to access the new images. 
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16b. Creating your own wordlist

You can also create a new wordlist to add your own pictures or word changes. From the 
Wordlist menu, choose Create empty wordlist.

Create a document that includes your new words. These may be exiting symbols or 
pictures with new words attached, or new images added to a word.  For example – to 
add a set of photographs of people in a group. Type their names into the document, and 
then drop their photos onto the words. 

When you are ready, select Save Wordlist Changes  from the Wordlist menu. 

Select the wordlist you want to add at the top of the dialog box, and then highlight the 
items from the list that you want to add. Click Add to add to the wordlist and click Done 
when all your changes are made. These lists are called subsidiary wordlists.

You can use a main wordlist, such as the ones described above, together with a 
subsidiary wordlist with specifi c vocabulary. Choose Merge wordlist from the Wordlist 
menu to open the second list.

16c. Setting the default wordlist

If you want to always use a wordlist other than the one that was supplied with the 
program when you purchased it, then you should change the default list from the 
Options/Start-up Preferences menu. You can also choose a default subsidiary wordlist 
that will also open automatically when you start the program. 
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16d. The Wordlist Manager

There is a utility program called the Wordlist Manager. This program allows you to edit 
wordlists, to create new ones and to merge existing lists to make longer ones. 

This utility is supplied with Communicate: Symwriter. You can access it by installing the 
trial version of Communicate: Symwriter. It will remain available on your machine after 
the trial has expired. More information and a download is available from 
www.widgit.com/support/wordlistmanager

If you are editing a wordlist in the Wordlist Manager, whilst you have Communicate: 
In Print open, you will need to refresh the wordlist in Communicate: In Print  in order 
to see your changes immediately. To do this go to the Wordlist menu and click Refresh 
wordlist.

16d. Using other Wordlists

It is possible to use wordlists from Writing with Symbols 2000 in Communicate: In Print. 
The wordlists are of a slightly different format and although you can use WWS 2000 
wordlists in the software, you cannot use the Communicate: In Print 2 wordlists in 
Writing with Symbols unless you convert them. You can convert wordlists in the Resource 
Manager that is supplied with Communicate: In Print.
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17. Ideas of things to do

These ideas are designed to help you practice some of the techniques described in this 
book and give some additional tips. The examples are included in your Communicate 
Files\In Print Writing folder. The books are in the Examples\Books to Print folder and 
the worksheets are in the Examples\Worksheets and resources folder. Also in the In 
Print Writing folder there is a folder called Templates. This has a number of ready-made 
layouts for you to use. You can save any of your own layouts in this folder as Templates.

1.  A picture book with symbol captions

Example New York

To product ‘ride’ type ‘passenger’ and then use the ‘change text’ button (or F11) to 
alter the word to ‘ride’  see page 28. Use the color palette icion to change the color 
of ride and the taxi to yellow. 

Guides have been placed to mark the top and bottom of the pictures and for the text 
lines.

A small frame has the page numbers in.

Another book of this type is Forest Book. In this fi le only the odd numbered pages 
have been fi lled in so that the book can be printed as a book folded.

Another version, called Forest has each page done for printing as sheets – either 
double sided or single sided.

Other examples of this type of book are the Thanksgiving and Christmas Stories.
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2.  A simple counting book

This book can be made from the template Counting 1-9 empty:

If you are using the template, you only need to add the pictures and the text. If you click 
on the number at the bottom of the page you will see a locked frame. Locked frames 
have grey drag points. A frame can have its position locked or its contents locked, or 
both. This one has the position only locked. This means that the student can’t delete or 
move the frame itself, only the contents.

If you are making a book like this from scratch, you can plan the book, making all of the 
pages with their frames ready, but without adding the content, and then save it into the 
Templates folder. Files saved in the Templates folder cannot easily be overwritten.

Another example is ‘Counting Food’, from the ‘Books to Print’ folder.
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This has the story in text on one page, and opposite a simpler text with symbols.

The picture was placed on the left hand page and copied (CTRL+C), then pasted on the 
next page (CTRL+V). This placed the graphic at the same size and in the same position as 
on the fi rst page.

In the symbol story the text has been adjusted so that there is one sentence to each line.

Print this Landscape, double sided as sheets, and bind it on the left, to open fl at as 
shown. If you choose to print it as a book the pages will be printed so that they are one 
above the other as you open it.

3. A book in text and symbols

Example Tortoise and Hare
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4.  An Odd one Out book

Example Odd one Out

The pages have been marked with guides using the rulers to mark out the squares where 
the images will be placed.

Make a single frame on your page.

From the frames menu, set the Appearance to be: 
corner radius 5; line thickness 6; border width 12 and internal space 1.

Right click in it to re-size it so that it appears like the illustration above, with 5 clear 
squares inside ready for the pictures.

Go to Frames menu and Make a table 1 frame wide and 7 frames down. If it doesn’t 
exactly fi t the space you can adjust it using the Yellow drag points.

Lock this in position.

Then copy this frame to all of the pages in your book except the covers. You can 
choose to have it locked on each page.

IMPORTANT: Change to Adjust mode. Now when you add the graphic it will sit on top of 
the frame and not be placed in it.

You can now add different graphics to each line, varying them by fl ipping or coloring to 
make the different exercises.

•

•

•

•

•

•
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5.  Activity book

This book has a number of activities in black and white line drawings suitable for 
printing as worksheets.

Page 1.
The items are typed into frames and then the text set to be white. This will ensure that 
there is enough space for the student to write under the picture.

Page 3.
These pictures are obtained using the Use List tab on the graphics Panel. Type the names 
of a number of words beginning with C into the list to fi nd suitable objects, and then 
add some distracters.

The size the graphics automatically appear is set in the Start-up Preferences box, under 
the Text Graphics tab. This is the bottom box, labelled Drop in graphics. A suitable size as 
in this example is 36.

Page 7.
The sets of three squares for the spelling activity can be made as a small table. Each one 
can then be copied and pasted to line up with the symbol on the left.

6.  Worksheets

Example worksheets are in the Examples\Worksheets and Resources folder.

The worksheet Peanut Butter and Jelly has one Fixed Symbol writing frame with the 
title. A Free symbol writing frame and 1 vertical set of pictures (taken from the Photos 
folder) and a vertical line to separate the words from photos.
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      Peanut butter and Jelly    Worksheet 1

There are many worksheets that can be made with the Template Worksheet 1. Type the 
instructions into the top frame and add the pictures to the frames in the table. In this 
example the pictures were added from the Graphics viewer. Alternatively type into the 
frames and get both picture and word.

This crossword uses tables for the crossword itself and for the clues. To make the table 
for crossword from the Fixed Text button, make a small frame with the line width 4, and 
the other settings 1. Size it for one square in the crossword. Set the font size small for 
the numbers.

Then make a table from that with the number of squares you want. The colored squares 
are made by setting the frame Appearance, background color.

The tables for the clues are made in a similar fashion but when they are all completed 
highlight the whole table and set the line color transparent. (It is easier to work with 
the lines visible while you are making it.)
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18. Managing fi les and getting students started

18a. Where work is stored

The main work fi les that you will need to access are stored in a folder called 
Communicate Files. On a stand alone machine the default location for this is C:\
Communicate Files.

In the Communicate Files folder there is a folder called In Print Writing, which holds 
all of your work saved from Communicate: In Print. This also includes Examples, which 
has examples of many different types of materials you can create in Communicate: In 
Print, a folder of Templates, which are frameworks for further work, and an In Print 
Starters folder.

18b. Where the graphics are stored

The colored pictures supplied with the program are in a folder called Widgit Pictures. 
The symbols are in a folder called Widresources. There is also a folder called Shared 
Pictures, where you could store your own pictures that you want to use in the 
program. At the bottom of the Graphics Panel there are shortcut buttons to the 
Widgit Pictures folder and to two other buttons. By default Button A links to your 
My Pictures folder in My Documents, and Button B links to the Shared Pictures folder. 
You can, however, change these links in the Start-up Preferences (found under the 
Options menu).

18c. Working on a network or a machine that has an individual log-on

If you are working on a machine or network that has different log-in levels for 
teachers and students then you will need access to the whole of the Communicate 
Files folder. Students can have access just to their own work folder, as set up on the 
network. If you would like individual students to have access to materials from the In 
Print Writing folder you need to copy them into the In Print Starters folder. When an 
individual student logs on to Communicate: In Print, any fi les that are in the In Print 
Starters will be copied into their own area in their own In Print Starters folder ready 
to use.

18d. Setting work for students

To start a student off with some templates or prepared materials, save them to your 
In Print Starters folder. These are copied to the student’s area when the student runs 
the program. You can remove the fi les from your folder later if you wish.
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19 Print test

Different printers vary in the way that they handle paper. In most cases you don’t worry 
about this because you only print on one side of the paper. However, if you want to 
print double sided from a non-duplex printer, you need to understand which way the 
printer handles the paper. This applies whichever application you are printing from.

19a. Which side of the paper does your printer print on?

Put an X in the leading edge of the paper as it goes into the Printer. Print a single page 
document (Print Test 1) (or a single page document from any other program).

Do you print on the same side as the X or on the opposite side?

If it is on the same side of the paper as the X then when you replace the paper into the 
feeder tray to print on the reverse side, the non-printed side(s) should be face up (or 
towards the printer). 

If the printing is on the opposite side, then you need to make sure that the non-printed 
side of the sheet(s) face down (or away from the printer).

19b. Which edge of the printed paper goes into the leading edge of the printer 
feeder tray?

When you are printing pages as sheets, the leading edge of the page (where the X was), 
is the top of the page. When you place the paper back in the tray you need to make sure 
that this same edge is again at the leading edge (but with the non-printed side ready to 
print). In the case of printing as sheets, this will normally mean that you take the paper 
out of the paper tray after printing and rotate it by 180 degrees.

Test this by printing a four page document ‘Portrait Printing Test’ (You could also try this 
with a document from any other program such as MS Word).

Set the printer dialog box to be Print as Sheets - one page per side, Double sided, and 
tick the box (Print second side in reverse).
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Print the fi rst side.

The following message will appear:

Take the paper out, rotate it by 180 degrees (as shown on the previous page) and 
replace it in the feeder tray with the non-print side ready to be printed. Then click OK to 
send the other sides to print.

Look at the results of the printing test you have done.

If the second side is upside down, then you don’t need to rotate the paper by 180 
degrees between printing the fi rst and second sides of Portrait Sheets.

19c. The order in which the pages are delivered

Is Page 2 on the back of page 1 or not? If page 4 is on the back of page 1 (instead of 
page 2) then you will need to set the default for Print second side in reverse to be OFF.

If necessary re-print the test for printing sheets, double sided, to ensure that you have 
the correct settings.
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19d. Printing other documents

The setting for Print second side in reverse will be the same for all documents printed on 
that printer.

Also the way that the pile of paper is presented to the printer with the side to print face 
down or face up will be the same for all documents.

The aspect that will change between different types of publication will be the horizontal 
rotation of the paper.

A Printing Landscape Sheets

Open the fi le ‘landscape printing test’, and print that also as double sided sheets. You 
will fi nd that the settings will be the same, except that you will probably not need to 
rotate the paper between printing the fi rst and second sides.

Record the results for correct printing in the form on page 4 of this document.

B Printing Portrait Books

Print this document ‘Portrait printing test’ with the settings as Book - ready to Fold and 
double sided. You will probably NOT have to rotate the paper between printing the fi rst 
side and the second sides.

C Printing Landscape Books

Print the fi le ‘landscape printing test’, a book, ready to fold, double sided. You probably 
WILL have to rotate the paper between printing the fi rst side and the second sides. 

Copy this settings chart and put it by the printer as a reminder.•

Test for Printing Double Sided Sheets
Name of printer:

Print second side in reverse  ON  OFF

Place second side to print  face up  face down

Printing Portrait sheets:
• Rotate paper before second side printing YES  NO

Printing Landscape sheets:
• Rotate paper before second side printing YES  NO

Printing Portrait Book ready to fold.
• Rotate paper before second side printing YES  NO

Printing Landscape Book ready to fold.
• Rotate paper before second side printing YES  NO 


